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INTRODUCTION

DD PC
CPU Clock speed:	 Dual Core 2 GHz or more (32 bit (x86) or 64 bit (x64) processor)
System memory:	 2 GB or more
Hard disk:		  At least 2 GB of free space.

DD Operating system
Windows Server 2019
Windows Server 2016
Windows Server 2012 R2
Windows Server 2012
Windows 11
Windows 10
Windows 8.1
• The RS-AP3 cannot be used with Windows RT 8.1.
• The RS-AP3 can be used with both 32 and 64 bit versions of the operating systems listed above.
• GUI environment only.
• These Instructions are based on using Windows 10.
• We recommend that you use a Solid State Drive (SSD) rather than a Hard Disk Drive (HDD) for saving the logs.
• These screen captures in the instructions may slightly differ, depending on the operating system used.

Thank you for choosing this Icom product. The RS-AP3 access point management tool is designed and built with 
Icom’s IP network technology. We hope you agree with Icom’s philosophy of “technology first.” Many hours of 
research and development went into the design of your RS-AP3.

i

Icom, Icom Inc. and the Icom logo are registered trademarks of Icom Incorporated (Japan) in Japan, the United States, the 
United Kingdom, Germany, France, Spain, Russia, Australia, New Zealand, and/or other countries.
Microsoft, Windows and Windows Server are trademarks of the Microsoft group of companies.
All other products or brands are registered trademarks or trademarks of their respective holders.

	 NOTE:
� �To start the wireless access point management, you must “Enable” the “Access Point Management Tools.” 
(+p.1-4)

	 Set the static IP address to your PC.
	 If you use the RS-AP3 for the first time, read through operation instructions written in the chapter 1.

System requirements
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•	 Wireless access points of the same model can be managed by one group.
	 A total of 64 groups can be programmed.

	 The license of the RS-AP3 is as follows.
	 Number of access points managed

➥➥ 3000 access points (maximum)/64 groups (total)
➥➥ 128 access points (maximum)/1 group

	 Number of groups
➥➥ 64 groups (total)

•	 Start the RS-AP3 to manage the access points in the groups.
	 Until the management is completed, changes cannot be made on an access point’s setting screen.
•	 Multiple access points can be managed individually or collectively.
•	� From the access points scanning results, power level and channels according to the system environment can 

automatically be set to the access points.
•	� Load balance can be managed based on information received periodically from the access points, according 

to the wireless LAN devices.
•	� Radio wave environment status can be displayed on a graph according into the data received from the access 

points.
•	� Management is automatically enabled when an access point to be managed is detected.
•	 The Site Survey function and MAC Authentication (RADIUS) server are inside the RS-AP3.
•	� The SSID or encryption settings for access points programmed to all groups can be displayed on a list.
•	� If an access point with a previous firmware version is detected, it can automatically be updated.
•	� Access point information can periodically be sent, or messages can be sent when an unauthorized access or  

a notification fault is detected.
➥➥ You can set it not to send messages when none of an unauthorized access or a notification fault is detected.

•	� Synchronizing the setting data with another PC with the RS-AP3 installed can avoid unmanageability caused 
by communication fault.

➥➥ When using the mirroring function, 2 different RS-AP3 (USB flash drives) on the same license are necessary.
•	� The RS-AP3 consists of the Windows service (shown below) that resides for managing the operating screen 

and wireless access points.

Operating screen Service

For editing settings and 
displaying logs.

As the Operating screen and Windows service 
are different programs, information is exchanged 
by using setting files.
�• �After editing the setting contents on the 

Operating screen, the setting file needs to be 
saved and applied to the Windows service 
side.

Managing wireless access 
points, according to the 
setting file contents.
�• �Operation star ts when 

Windows starts

Product information
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•	� When the RS-AP3 USB flash drive is inserted into the USB port, “REMOVABLE drive” and “Setup.exe” ap-
pear.

	� The flash drive must be inserted into the PC when saving the setting files or synchronizing with the mirroring 
function.

•	� The RS-AP3 resides as a Windows service. Therefore, you can manage the access points, using saved set-
ting files.

	 After setting the access points to manage on the operation screen, remove the flash drive.
➥➥ Modifications are applied to the service when the contents modified with the software are overwritten.
➥➥ �If you load a setting file that is saved in advance, save it again with the RS-AP3.

•	� To synchronize the setting data between the RS-AP3 and an access point, overwrite the settings entered on 
the operation screen, and then send them to the access point.

•	� When the access point management is completed (+p.1-21), “Access Point Management Tools” automati-
cally return to “Disable.”

	� To manage the access point again, you must “Enable” the “Access Point Management Tools.”
	 (+p.1-4)
•	� When using the Wireless Bridging communication function, you must activate the function in order for the ac-

cess points to communicate, before enabling the “Access Point Management Tools.”
•	� As of April 2022, the only wireless access point that can be used with the RS-AP3 is Icom’s AP-90M and 

AP-95M.

Installation note

When managing a wireless access point with a router function:
• The WAN router settings of the wireless access point cannot be changed.

When managing a wireless access point with a router function from the WAN side:
• �Set the connection type to “Static IP” and enter a static IP address for the WAN side IP address, before 

starting the system management.
➥➥ �When setting the connection type to “DHCP client,” set the Static DHCP server function on the DHCP server side 
so that  the same IP address is always given.

➥➥ �When setting the connection type to “PPPoE,” you cannot manage the system from the WAN side of a wireless 
access point.

• �When accessing the WAN side of the wireless access point using the RS-AP3, set the [Open management 
ports of RS-AP3] item to “Enable,” or set an appropriate IP filter so that the RS-AP3 can access from the 
WAN side.

➥➥ �When you set the [Open management ports of RS-AP3] item to “Enable,” an IP filter is automatically set so that the 
RS-AP3 can access the system from the WAN side.
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1.	Before using the RS-AP3

Before using the RS-AP3 for the first time, follow these instructions.

1. Setting the wireless access point IP address� (+p.1-3)
	� Set the IP address and network settings on the “IP Address” screen to 

manage with the RS-AP3.

1.	Starting the RS-AP3� (+p.1-5)

2.	Setting the wireless access point to RS-AP3 mode (+p.1-4)
	� Before using the RS-AP3, you must “Enable” the “Access Point Man-

agement Tools” on the setting screen.

2.	Adding groups� (+p.1-7)

3.	Adding wireless access points� (+p.1-8)

4.	Setting wireless access point IP address� (+p.1-10)
	 Set the IP address set for the access point. 

5.	Saving the setting data� (+p.1-11)
	� Save the access point setting data as a setting file (extension: rsap3) 

on the PC.
	� • �After editing the contents, you must save the setting file and apply it 

to the Windows service.

6.	Starting the management� (+p.1-13)

7.	Importing wireless access point settings� (+p.1-14)
	� To reuse the contents set to the access points, load the setting data 

from access point.

8.	Changing the wireless access point settings� (+p.1-16)
	� If needed, click [Individual Configurations] and [Common Configura-

tion] to change the access point setting contents.

9.	Overwriting the setting data� (+p.1-18)
	� • �After editing the contents, you must save the setting file and apply it 

to the Windows service.

10.	Sending the modified settings� (+p.1-19)

11.	Ending the management� (+p.1-21)
To continue the management on the Windows service, skip to the steps 
on page 1-23.

12.	Closing the RS-AP3� (+p.1-23)

1.
SETTING THE WIRELESS

ACCESS POINT

2.
STARTING THE RS-AP3
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2.	Setting the wireless access point

Edit the [IP Address] settings on the “IP Address” screen, and then click [Apply].
• �If you want to change the IP address’s “network part (Example: 192.168.0),” also change the IP address on 

the PC.

After restarting, click [Back].
The “Login to AP-90M” window is displayed to enter the user ID and password.

1

2

3

1.	 Setting the wireless access point IP address

�Set the IP address and network settings for the access point on the “IP Address” screen.
• Make sure the IP address is not the same as the other network’s address.
• Refer to the access point’s instruction manual for details on accessing the setting screen.
• The instruction manual is described based on the AP-90M.

w Click

q Edit

Click

Click [Reboot].
• �Follow the instructions to restart the AP-90M.
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2.	Setting the wireless access point (Continued)

Click “Management” and then “Management Tools.”
The “Management Tools” screen is displayed.

“Enable” the [Access Point Management Tools].

Click [Apply].

1

2

3

2.	 Setting the wireless access point to the RS-AP3 mode 

Before using the RS-AP3, you must set the “Access Point Management Tools” to “Enable.”

Select

Click

When managing a wireless access point with a router function:
• The WAN router settings of the wireless access point cannot be changed.

When managing a wireless access point with a router function from the WAN side:
• �Set the connection type to “Static IP” and enter a static IP address for the WAN side IP address, before 

starting the system management.
➥➥ �When setting the connection type to “DHCP client,” set the Static DHCP server function on the DHCP server side 
so that  the same IP address is always given.

➥➥ �When setting the connection type to “PPPoE,” you cannot manage the system from the WAN side of a wireless 
access point.

• �When accessing the WAN side of the wireless access point using the RS-AP3, set the [Open management 
ports of RS-AP3] item to “Enable,” or set an appropriate IP filter so that the RS-AP3 can access from the 
WAN side.

➥➥ �When you set the [Open management ports of RS-AP3] item to “Enable,” an IP filter is automatically set so that the 
RS-AP3 can access the system from the WAN side.
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3.	Starting the RS-AP3

1.	 Starting the RS-AP3

NOTE:
• �After the installation has completed, the RS-AP3 USB flash drive must also be inserted into the PC 

when you first run the RS-AP3 software.
• �After running the software for the first time, the flash drive does not have to be inserted.
	� When a USB flash drive needs to be inserted, such as in the following operation, insert the same flash 

drive that you used when you first ran the software.
➥➥ Saving or opening a setting file.
➥➥ Synchronizing using the mirroring function. (☞p.6-10)

Click the RS-AP3 icon in the Start menu.
You can also start the software by simply double-clicking the RS-AP3 icon on your desktop.
• These Instructions are based on using Microsoft Windows 10.

If the “User Account Control” window appears, click [Yes] to continue.

1

2

w Click

q Click
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NOTE:
The next time you start the RS-AP3, you will need to enter the User ID and the password that you en-
tered.
• Without the User ID and Password, you cannot start the RS-AP3.

If you click [Reset Password], the User ID and Password are cleared, and will have to be reentered.
• �To open the setting file saved with a different User ID or Password (+p.1-11), the User ID and Password entry 

window appears. (+p.2-3, p.3-2)
	� To open the setting files saved with a different User ID and Password, enter the ones that you entered when you 

saved them.

3.	Starting the RS-AP3 (Continued)

1.	 Starting the RS-AP3 (Continued)

Enter a desired User ID, Password and Password (Confirm) of up to 31 characters and symbols, and then 
click [OK].
• Use numbers, characters and letters (both lower and upper case).

4

w Click

q Click

Select the country code from the drop-down list.3

w Click

q Click
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3.	Starting the RS-AP3 (Continued)

2.	 Adding wireless access point groups

Select the access point device to assign to the new group to, and then click [OK].

Select the assigned group.
Enter a “Title” (up to 32 characters), ”Background Bitmap,” for example.
• Only the same access points can be managed in a group.
• �To set the common configurations to a different access point, you need to separate into different groups to 

manage.

1

2

w Click

q Click

q Click w Set

When setting the Background Bitmap
First, save the picture file (24 bitmap format) in 
the RS-AP3 installated folder. (Icom > RS-AP3 > 
BG) (+p.6-14)
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Locking the wireless access point icons
�To lock the access point icons, select the access point on the map screen and click “Access point,” and 
then click “Lock Icons.”

• Even while it is locked, the coordination (positioning) can be changed in Property on the map screen. (+p.1-10)

3.	Starting the RS-AP3 (Continued)

3.	 Adding wireless access points

Click “Access Point,” then “Add” to add an access point to a group.
• You can also add an access point from the menu that is displayed by right-clicking on the map screen.

q Click

w Clickq Click

e Click

w Click
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3.	Starting the RS-AP3 (Continued)

3.	 Adding wireless access points (Continued)

Deleting a wireless access point
To delete an access point, select the access point on the map screen and click “Access point,” and then 
click Lock icons.

• The icon can also be deleted from the menu that is displayed by right-clicking on the map screen.

w Click

q Click

e Click
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 3. Starting the RS-AP3 (Continued)

 4.  Setting wireless access point  IP address

 Select the added access point, and then enter the IP address.
Enter the “Display Name” (of up to 32 characters) and select the icon from the “Bitmap” list.
•  To manage the access points with the RS-AP3, you need to enter an IP address.
•  Selecting an access point icon on the map screen will display the access point’s name and information in the 

“Property” display.

Repeat “Adding wireless access points” (+p.1-8) and the above settings to add access points to 
the group.

1

2

q Click w Set

If necessary, enter 
“Display Name,” “Bitmap,” 
and “X/Y Coordinate.”

 Importing/ Exporting access point information

The registered access point’s information* can be exported in the 
CSV format, or the exported fi le can be imported into the RS-AP3.
•  If the access point’s IP address is the same as other group’s IP ad-

dress, the information cannot be imported or exported.
•  If the information is the same as the registered access point, the infor-

mation is overwritten.
• An exported fi le can be edited with a text editor.
• Importing other fi les than the exported fi les is not guaranteed.
*  Access point information includes group and model title, IP address, 

display name and coordinates (positioning) on the map screen.
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3.	Starting the RS-AP3 (Continued)

5.	 Saving the access point setting data

Save the access point setting data as a setting file (extension: rsap3) on the PC.
• The last saved setting file automatically loads the next time you start the software.
	 We recommend that you do not move the setting file from where you saved it.

Click “File” and then “Save As...”
Clicking , or double-clicking  on the status bar, will also save the setting data.

1

When the “Save As...” window is displayed, set the desired file name, and then click [Save].
• The setting file (extension: rsap3) is saved in the selected location.

2

q Click w Click

q Set

If necessary, change the 
location.

w Click
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3.	Starting the RS-AP3 (Continued)

5.	 Saving the access point setting data (Continued)

Modifying the settings
If the setting data is modified after the file has been saved, “*” appears on the title bar and the group 
title.

NOTE
When saving a setting file, you must insert the 
USB flash drive that was used when the RS-
AP3 started.
If the dialog to the right is displayed, insert the 
flash drive, and then click [Retry].

The settings modified in 
the individual or common 
configurations are dis-
played in bold letters.
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3.	Starting the RS-AP3 (Continued)

Click “Access Point” > “Manage” > “Start (All)...”
• You can select it from the menu that displays by right-clicking on the map screen.
• �To start managing the access points one by one, select the access point on the map screen, and then click 

[Start].

1

q Click w Click

e Click

Click [Yes].2

When you start the access point management, “Succeeded in the management start command” is 
displayed.
• �If “Failed in the management start command” is displayed, check the access point connection of the IP ad-

dress.

3

Check

NOTE

To start the management, you must “Enable” the “Access Point Management Tools.”
�When you finish the access point management (+p.1-21), the management tool settings on the access 
point automatically returns to “Disable.”

6.	 Starting the management

When the management is started, the access point’s setting data can be imported (+p.1-14) or exported 
(+p.1-19) from the RS-AP3.
• The settings on the access point setting screen cannot be modified until the management is finished.
• Refer to page 2-7 for the access point status display (color) details.

Click
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3.	Starting the RS-AP3 (Continued)

Click “Access Point” > “Settings” > “Import to Individual Configurations (All)...”
• You can select it from the menu that is displayed by right-clicking on the map screen.

1

Click [Yes].2

When the setting data is imported, “Succeeded in importing settings to Individual Configurations” 
displays.
• �If “Cannot import to Individual Configurations” is displayed, check the access point connection of the IP ad-

dress.

3

7.	 Importing wireless access point settings

To use the contents set to the access points, import the configuration data from the access points.
• �To set the “Common Configuration” contents (+p.5-1) as the access point setting, select the access point on the map 

screen, and then load the setting data. (+p.1-15)

e Click

q Click
w Select

Click

Check



1 USING THE RS-AP3

1-15

3.	Starting the RS-AP3 (Continued)

7.	 Importing wireless access point settings (Continued)

w Click e Select r Clickq Click

Importing setting data individually from wireless access points
Select the access point on the map screen, and then click “Access Point” > “Settings” > “Import to Indi-
vidual Configurations...” or “Import to Common Configuration...”

• You can select it from the menu that is displayed by right-clicking on the map screen.



1 USING THE RS-AP3

1-16

3.	Starting the RS-AP3 (Continued)

8.	 Changing the wireless access point settings

�If necessary, click [Individual Configurations] or [Common Configuration] to change the access point setting 
contents.

Individual Configurations:	 Individually sets access points
Common Configuration:	 Sets all access points in the group

• The Individual Configuration contents take prior over the Common Configuration contents.
• �To set the common configurations to a different product, you need to separate into different groups to manage.
• Only the same products can be managed in a group.
• Refer to the access point’s instruction manual or the setting screen online help.

q Click

e Setw Click

Setting on the Individual Configurations screen
Select the setting access point from the access point list in the selected group, and then click the setting 
item.
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3.	Starting the RS-AP3 (Continued)

8.	 Changing the wireless access point settings (Continued)

w Set

Setting on the Common Configuration screen
Among the access points set to the selected group, click the items to set in the group.

q Click
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3.	Starting the RS-AP3 (Continued)

9.	 Overwriting the setting data

To apply the modified access point setting contents to the Windows service, click “File” and then “Save” to 
overwrite the setting file. (extension: rsap3)
• Clicking  or double-clicking                  will also save the file.
• To manage the access points using the saved setting files, save the changes constantly to apply it to the service.

q Click w Click

NOTE
When saving a setting file, you must insert 
the USB flash drive that was used when the 
RS-AP3 started.
If the dialog to the right is displayed, insert the 
flash drive, and then click [Retry].
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3.	Starting the RS-AP3 (Continued)

10.	Sending the modified settings

To apply the setting contents modified with the RS-AP3, send the setting data to the managing access 
points. 

Click “Access Point” > “Settings” > “Send (All)...”
• �You can select it from the menu that appears by right-clicking on the map screen.
• �To individually send a setting data by each access point, select the access point on “Individual Configurations” 

or on the map screen, and then click “Send...”

1

Click [Yes].2

When the setting data is sent, “Sending the configuration completed” appears.
• �If “Failed to send the configuration” is displayed, check the access point connection of the IP address.

3

 Check

e Click

q Click w Select

 Click
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3.	Starting the RS-AP3 (Continued)

10.	Sending the modified settings (Continued)

NOTE

Before you send the modified settings, you need to save them 
first.
If the dialog to the right is displayed, click [OK] and then save.
(+p.1-18)
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3.	Starting the RS-AP3 (Continued)

11.	Ending the management

To close the operating screen and continue the management on the Windows service, skip to the steps on 
page 1-23.
• The settings on the access point setting screen cannot be modified until the management is finished.
• If there are multiple groups to manage, finish the management one by one.

Click “Access Point” > “Manage” > “End (All)...”
• �You can select it from the menu that displays by right-clicking on the map screen.
• �To end a setting data by access point, select the access point on “Individual Configurations” or on the map 

screen, and then click “End...”

1

Click [Yes].2

e Click

q Click w Select

To continue the management on the Windows service, skip to the steps on page 1-23

NOTE

�When you finish the access point management, the management tool settings on the access points 
automatically returns to “Disable.”
To start the management, you must “Enable” the “Access Point Management Tools.” (+p.1-4)

Click
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3.	Starting the RS-AP3 (Continued)

11.	Ending the management (Continued)

When the access point management is ended, “Sending the management stop command succeed-
ed” displays.
• �If “Failed in the management stop command” is displayed, check the connection for the access point of the its 

IP address.

3

Check
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3.	Starting the RS-AP3 (Continued)

12.	Closing the RS-AP3

Click “File,” and then “Exit” to close the RS-AP3.
• Clicking [X] also closes the RS-AP3.

q Click

w Click

If the management is not ended:
While managing an access point, and the “Exit” is selected, the dialog below appears.

• To continue the management, click [Yes].
➥➥ The RS-AP3 will close (Setting with other than the RS-AP3 is disabled.)

• To end the management:
	 1. Click [No], and then click “Access Point” > “Manage” > “End All...”
	 2. Click “File,” and then “Exit” to close the RS-AP3.

➥➥ If there are multiple groups to manage, finish the management one by one.
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1.	Screen description

Refer to the pages shown after the item for each operation displayed on the operation screen.

Top menu
(+p.3-1 to p.3-36)

Property screen
(+p.2-9 to 2-11)

Tool bar
(+p.2-3)

Title bar
(+p.1-12)

Group tab/ 
SYSLOG tab
(+p.2-4)

Map screen
(+p.2-6)

Map tab/ Individual 
Configurations/
Common Con-
figuration tab 
(+p.2-5)

Status bar
Displays explanations for the selected operation.

Output Log 
screen
(+p.2-8)
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2.	Tool bar

q	  New(Ctrl+N)...............Creates a new document.

w	  Open(Ctrl+O)............. Opens an existing document.
	 • �To open a document (extension: rsap3) saved with a different User ID and password,  

enter the ID and password you used when you saved the document, in the dialog 
shown below.

e		  Save(Ctrl+S)............. Saves the active document.
	 • �When saving for the first time, you need to first name the document, then save it.

r		  About........................ Displays the program information, version number, and the copyright.

The Tool bar is used to create, open or save a new RS-AP3 setting file.

KqKwKe Kr
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3.	Group tab and SYSLOG tab

q Group tab........................ �When you want to manage networks by floors, you can divide the access 
points into groups.

		  • Only the same model of access points can be managed in a group.
		  • �To set the common configurations for a different access point, you need to separate 

into different groups to manage.
		  • The group title can be changed in the “Property” screen. (+p.2-9)
		  • �The groups can be added or deleted by right-clicking the Group tab, or from the Group 

menu. (+p.3-3)

w SYSLOG tab.................... �Displays the RS-AP3’s SYSLOG (log history.) (+p.2-12)

The tabs are used for access point management, or to check the SYSLOG.

Kq Kw

When the [Group] tab (Example: New Group 01) 
is clicked.
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4.	Map tab, Individual tab and Common tab

q Map tab................................................. �Click to display the map screen. (+p.2-6)
		  It is used to add or manage access points.

w Individual Configurations tab.............�Click to display the Individual Configurations screen. (+p.4-1)
		  It is used to set access points one by one.

e Common Configuration tab................�Click to display the Common Configuration screen. (+p.5-1)
		  It is used to set access points by groups.

The tabs displayed on the operation screen when [Group] (example: New Group 01) is clicked.

Kq Kw Ke
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Access points can be added or deleted from the “Access Point” menu.
• You can also do the same from the menu displays by right-clicking on the map screen.
• �To set the background, save the desired bitmap formatted (24 bit) image file in the “BG” folder that is located in the 

same location where the RS-AP3 is installed. (+p.6-14)

5.	Map screen

The screen allows you to add, delete and manage access points by selected groups.

You can display the access point management 
status by locating the cursor.

Group tab/ 
(+p.2-4)



2 OPERATING SCREEN

2-7

5. Map screen (Continued)

 Wireless access point title blinks

The access point status blinks in colors.

Icon (example) Blinking color Status

Red

• Communication not yet established.
• Management not started.
•  No notifi cation from the access point for more than the time set in “Fault Log 

Timer” (+p.3-34).
• Rebooting.
• Firmware updating.
  –  When the blinking is caused by other than [No notifi cation from the access point for more 

than the time set in “Fault Log Timer”], is when the communication is not yet established.
     This status is also applied when overwriting a fi le or starting the RS-AP3.

Red
(Characters)

• The virtual AP is suspended by the network monitoring.
• Wireless is paused during the assigned wireless shutdown schedule.
•  Wireless is paused because wireless 1 and 2 frequency bands (2.4 GHz/5GHz) 

are set identically.

Yellow  Detected illegal access.

Orange

• Checking for radar for DFS.
• The automatic control is enabled.
• Scanning channels as a wireless bridging client.
• Site surveying.

Grey Firmware update is necessary.
• Despite the old and new version of the access point.

Purple

Discrepancy in the settings between the RS-AP3 and the access point.
•  Besides settings, when the hash value is incorrect when importing the settings, 

blinks in purple.
  In this case, the setting data needs to be sent.

Blue Sending the setting data.
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6.	Output Log screen

This screen displays the information on the server or the illegal access detection log history.
When the log saving setting (+p.3-27) is enabled, the log is displayed on the operation screen and saved 
in the log file.
In total of 1000 lines can be displayed, and the older lines are automaitcally deleted.

About the Log

Right-click on the “Output Log” screen, the menu as shown below.
• To deselect the selected log, click the selected line while pushing [Ctrl].

About the Output Log screen display

Right-click on the “Output Log (             ),” the menu as shown below.

K

K

K

K

K

q

w

e

r

t

q Floating........................... �Displays only the “Log Output” screen.

w Docking........................... �The “Log Output” screen and the operation screen are combined.
(“Docking” is set as default)

e Tabbed Document.......... �This menu is disabled at all times.

r Auto Hide........................ �Automatically hides the “Log Output” screen while not used.

t Hide................................. �Hides the “Log Output” screen.
		  • To display the “Log Output” screen, select “Log Output” in the “View” menu. (+p.3-35)
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7.	Property screen

The Property screen displays the title (Group name), background, selected access point name, and IP 
address, and you can set them on this screen.

q Model............................... �Displays the selected group’s model.

w Title.................................. �Displays the selected group’s title of up to 32 characters.
		  The title is also displayed on the Group tab. (+p.2-4)

e Background Bitmap....... �A bitmap image file (24 bit color) saved in the “BG” folder can be set as the 
background image. (+p.6-14)

		  • The “BG” folder is located in “Icom” > “RS-AP3” in the RS-AP3 installation folder. 
		  • If the image is not located in the folder, this option cannot be selected.

r Zoom in/out.................... �Zooms in or out the background between 50~300 %.
 
t Display Name................. �Enter the display name of the access point selected on the map, of up to 32 

characters.
		  • �The entered name will display on the map screen and the “Individual Configuration” 

screen.

y IP Address...................... �Displays the IP address set to the access point selected on the map screen.
		  • �Make sure that the correct IP address is set, otherwise the management cannot be 

started.

u Bitmap............................. �Select the access point icon to display on the map screen.
		  The bitmap automatically changes, depending on the model settings.(+p.1-7)
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7.	Property screen (Continued)

i X Coordinate................... �Displays and sets the access point icon’s horizontal coordination.
		  Set between 0 and 2048.

o Y Coordinate................... �Displays and sets the access point icon’s vertical coordination.
		  Set between 0 and 2048.

K
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 7. Property screen (Continued)

q  Floating ..........................  Displays only the “Property” screen.

w  Docking ..........................  The “Property” screen and the operation screen are combined.
(“Docking” is set as default)

e  Tabbed Document .........  This menu is disabled at all times.

r  Auto Hide .......................  Automatically hides the “Property” screen while not used.

t  Hide ................................  Hides the “Property” screen.
  • To display the “Property” screen, select “Property” in the “View” menu. (+p.3-35)

About the Property screen display

Click on the Property screen to display the screen as shown below.
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8.	SYSLOG screen

Click the “SYSLOG” tab to display the log information.
In total of 1000 lines can be displayed, and the older lines are automatically deleted.
• To save the log information, make sure “Option” > “Save Log” > “SYSLOG” is selected. (+p.2-15, p.3-27)

• SYSLOG is saved separately by date and IP address (extension: txt), and also divided by approximately 64 KB files.

SYSLOG tab
(+p.2-4)
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8. SYSLOG screen (Continued)

About the Filter

Right-click on the “SYSLOG” screen to extract the desired log information from “Filter.”

Extracting by “ Date and Time...”

q Right-click w Click

e Click

r Select

q Right-Click w Click e Click

 + Continued on the next page

Extracting by “ Facility”
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8.	SYSLOG screen (Continued)

About the Filter (Continued)

Extracting by “Level”

q Right-click w Click e Click
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 8. SYSLOG screen (Continued)

 Log Folder setting

Follow the instructions below to change the folder to save SYSLOG in.
• We recommend that you use a Solid State Drive (SSD) rather than a Hard Disk Drive (HDD) for saving the logs.

r Click

q Click w Click

e Click
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8. SYSLOG screen (Continued)

q Right-click w Click

 Opening SYSLOG

Right-click on the “SYSLOG” screen and select “Open” to open a SYSLOG file (extension: txt).

e Select

r Click
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1.	File menu

q	New(Ctrl+N)..............................Creates a new document.

w	Open(Ctrl+O)............................Opens an existing document.
	 • �To open a document (extension: rsap3) saved with a different User ID and pass-

word, you need to enter the ID and password you entered when you saved the 
document, in the dialog shown below.

e	Save(Ctrl+S).............................Saves the active document.

r	Save As... .................................Saves the active document with a new name.

t	Import the Access Point... ..... �Imports access point information file (extension: csv) to the RS-AP3.
	 • �If the information same as the registered access point is imported, the informa-

tion is overwritten.
	 • �You can import only the file that is exported from [Export the Access Point] 

(y).

y	Export the Access Point... ..... �The registered access point information can be exported (extension: csv)
	 • �Access point information includes group and model title, access point IP ad-

dress, display name and coordinates (positioning) on the map screen.
	 • An exported file can be edited with a text editor.

u	Exit ........................................... �Closes the RS-AP3
	 • Clicking [X] also closes the RS-AP3.
	 • �To continue managing with the Windows service, save the changes and close 

RS-AP3 operating screen.

The File menu is used to create, open or save a new RS-AP3 setting file (extension: rsap3).

1
2
3
4

5
6

7
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2.	Group menu

Selecting a group by right-clicking

The Group menu is used to add or delete a group.
• Only the same model access points can be managed in a group.
• To set the common configurations for a different access point, you need to separate into different groups to manage.
• While selecting the “SYSLOG” screen, [Delete...] is displayed in grey.

q Click

w Select

q Right-click

w Select
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Setting the Title (group name)/Background Bitmap
• If necessary, enter a title (group name) of up to 32 characters from the “Property” screen.
• �Click “Background Bitmap” on the “Property” screen to select a 24 bit bitmap formatted image file saved in the “BG” 

folder located in the RS-AP3 installed folder.
	 Refer to “Background bitmap setting” on page 6-14 for details.

2.	Group menu (Continued)

Set

The entered title (group name) displays.

q	Add...........................................Adds a group.
	� Click to display the “Add a group” dialog.

	� Select the access point model for the new group, and then click [OK].

w	Delete........................................Deletes a selected group.
	 • �The selected group’s access point information is also deleted.
	 • �Confirm that the selected group and the access point information is deleted.
	 • �While managing an access point, its settings cannot be modified on the access 

point setting screen.
	   �If you have mistakenly deleted a managing group, add a group and access 

points and set them again.

1
2

3
4
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 2. Group menu (Continued)

e  Security Dashboard ................  Displays the SSIDs and encryption settings for all the access points reg-
istered in the group in a list.

 r  Automatic Control ..................  Displays the Automatic Control menu which confi gures the access points 
in the same group, according to the setting environment.

 •  It is activated when “Option” > “Automatic” > “Automatic Control” > “Automatic 
Control”  is selected.

K
K
q
w

q  Start...  ................................  According to the scan results, the power level and the channel that applies 
with the system enviroment are set to the access point.

  To adjust the neighbor access point’s power level that has a disability, 
you need to activate the Automatic Control beforehand.

 •  If adjustment has been modifi ed, “(Auto)” displays in the power level, channel, or  
access point status fi eld (+p.2-6) on the “Status” screen (+p.3-19).

 •  “Use Common Confi guration” is selected in Wireless LAN in the Individual Con-
fi gurations, and the access points with their transparent display names on the 
map screen are subjected.

 •  Before starting the Automatic Control, start managing all the access points in 
the group.

w  Reset  ..................................  Returns the access point’s power level and channel modifi ed by 
the Automatic Control to the “Individual Confi guration” or “Common 
Confi guration” screen contents.

1
2

3
4
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3.	Access Point menu

The Access Point menu is used to add, delete, start or end the management of the access point, and to 
update the firmware, detect illegal access and display the status, and so on.
�• �To manage access points one by one, select the access point on the map screen first, and then start the manage-

ment.

Selecting by right-clicking the wireless access point icon

q Click

w Select

q Right-click

w Select
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q	Add...........................................Adds an access point.
	� Select the added access point, and then enter the IP address.
	 • �The access point without its IP address entered on the “Property” screen 

cannot be managed with the RS-AP3.
	 • �When the number of the access points has reached the maximum, this 

option is greyed out.

w	Delete... ....................................Deletes the selected access point.
	 • After deleting, confirm that the group is successfully deleted.
	 • �A currently managing access point cannot be set on the access point’s setting 

screen.
	   If you have deleted by mistake, add an access point and set it again.

e	Manage.....................................Displays the access point management menu.
	 • �The access point without its IP address entered on the “Property” screen 

cannot be managed with the RS-AP3.

3.	Access Point menu (Continued)
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e Manage (Continued) ...............

q  Start... ......................................Starts managing the selected access point.
 •  Access points’ settings cannot be modifi ed on the access point’s setting screen 

until the management is fi nished.

w  Start (All)... ..............................Starts managing all the access points in the group.
 •  If there are multiple groups to manage, start managing group by group.

e  End... ........................................Ends managing the selected access points.

r  End (All)... ................................Ends managing the access points in the selected group.
 •  If there are multiple groups to manage, end managing group by group.

3. Access Point menu (Continued)

NOTE:
 To start the access point management, you must “Enable” the “Access Point Management Tools.”
 When you fi nish the access point management, the management tool settings on the access points 
automatically return to “Disable.”
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r  Settings ...................................  Displays the menu to export or import setting data to the managing ac-
cess points.

q  Send... ......................................  Sends the setting data modifi ed on the “Individual Confi gurations” 
screen or “Common Confi guration” screen to the selected access point. 
(+p.4-1, p.5-1)

w  Send (All)... ..............................  Sends the setting data modifi ed on the “Individual Confi gurations” screen 
or “Common Confi guration” screen to the access points in the selected 
group. (+p.4-1, p.5-1)

e  Import to Individual
 Confi gurations... .....................  Imports the setting data on the “Individual Confi gurations” screen from 

the selected acess point. (+p.4-1)

r  Import to Individual
 Confi gurations (All)... .............  Imports the setting data on the “Individual Confi gurations” screen from 

the acess points in the selected group. (+p4-1)

t  Import to Common 
 Confi guration... .......................   Imports the setting data on the “Common Confi guration” screen from the 

selected acess point. (+p.5-1)

3. Access Point menu (Continued)
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t  Firmware .................................  Displays the menu to update the access point fi rmware.
 •  If the AP-90M’s fi rmware does not match the RS-AP3’s fi rmware, the access 

point’s fi rmware automatically updates. (When “Option” > “Automatic” > “Firm-
ware Update” is selected) (+p.3-24)

q  Update... ..................................Updates the selected access point to the RS-AP3’s fi rmware.

w  Update (All)... ..........................  Updates the access points in the selected group to the RS-AP3’s 
fi rmware.

3. Access Point menu (Continued)
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y  Site Survey ..............................  Displays the Site Survey menu.
 •  The access point cannot communicate with the wireless LAN terminal during a 

site survey.

q  Start... ......................................Starts a site survey for the selected access point.

w  Start (All)... ..............................  Starts a site survey for the access points in the selected group.

e  Delete Results... ......................  Deletes a selected access point’s site survey results.

r  Delete Results (All)... ..............  Deletes a site survey results of the access points in the selected group.

3. Access Point menu (Continued)

 + (Continued on the next page)
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y Site Survey (Continued) .........

t  Display Results (Line) ............  Draws the site survey results in lines.
 •  The purple lines (+p.3-16) stand for the channel (frequency) used for commu-

nication, and the line type stands for the strength of the signal.
 •  The directions of the arrow indicate the signal’s direction.

3. Access Point menu (Continued)

The broken line indicates that the signal 
is weak, and the thicker the line is, the 
sronger the signal is.

 + (Continued on the next page)
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y Site Survey (Continued) .........

t Display Results (Line)
 (Continued) .............................  After the site survey, clicking the access point icon while pushing [Shift] 

will display only the indicating line of the access point’s transmitting signal 
strength.

3. Access Point menu (Continued)

Click while 
pushing [Shift]

 + (Continued on the next page)
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y Site Survey (Continued) .........

t Display Results (Line)
 (Continued) .............................  After the site survey, clicking the access point icon while pushing [Ctrl] will 

display the indicating line of the access point’s receiving signal strength.

3. Access Point menu (Continued)

Click while 
pushing [Ctrl]
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y Site Survey (Continued) .........

y  Display Results (List) .............  Displays the site survey results in a list.

3. Access Point menu (Continued)

BSSID The detected device’s “BSSID.”

Channel The detected device’s channel.

RSSI
The strength of the received signal detected from the 
device.
• Higher values indicate stronger signals.

Mode
If the detected device is a wireless access point, “AP” 
appears, and if it is a wireless LAN terminal operated in 
the ad hoc mode, “ADHOC” appears.

Security

Displays the encryption and authentication protocols 
that the detected device uses to communicate.
•  When the system is “WEP RC4” or “OCB AES,” “WEP” 

is displayed.

SSID The detected device’s “SSID.”
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y Site Survey (Continued) .........

 u  Color Settings... ......................  Sets the display color of the frequencies used in the “Display Results (Line).”

 “Color Settings” window
  Place check mark to display the frequency in a specifi ed color line.
 If a check mark is removed, the frequency is not displayed in a color line.

(Default: [✔] displayed)

3. Access Point menu (Continued)
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y Site Survey (Continued) .........

u Color Settings...(Continued) ..“Colors” window
  Click a color in the “Color Settings” window to display the “Colors” window, 

and then change the color.
 • Clicking  [Default] resets to the default color.

3. Access Point menu (Continued)
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u  Illegal Access
 Detection Log... ......................  When an illegal access has been detected, the display name of the 

subject access point blinks in yellow.
  Select the blinking access point, and then click “Illegal Access Detection 

Log...” to stop the blinking and to display the “Illegal Access Detection Log” 
screen.

 •  To save the illegal access point log, place a check mark in “Illegal Access De-
tection Log.”

   (Option > Save Log > Illegal Access Detection Log)
 • The RS-AP3 detects an illegal access when:

 ➥The connection is rejected by the MAC address fi ltering system.
 ➥The connection is rejected by exceeding the maximum number of stations.
 ➥ A station is disconnected by a MIC failure (replay protection) in the WPA 
authentication.

3. Access Point menu (Continued)
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i	Status....................................... �Displays the contents (IP address, channel, BSSID and so on) of the 
selected access point being managed on the “Status” screen.

3.	Access Point menu (Continued)
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o	List of Connected
	 Stations.................................... �Displays the information of the wireless LAN terminals communicating 

with the selected access point (MAC Address, RSSI, Tx Rate and so on) 
on the “List of Connected Stations” screen.

3.	Access Point menu (Continued)
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!0	Traffic Statistics....................... �Displays the communication traffic statistics in a graph by searching the 
history log.

q	Start date/time/period............. �Sets the starting date, time and period of the search.
	� Date:	 Directly enter or click [] to select from the calendar.
	 Time:	 Select between 00:00 and 23:00 (1 hour step.)
	 Period:	 Select between 1, 3, 6, 12 and 24 (hour.)

w	Interface................................... �Displays the interface names and their colors.
	� When an interface is selected, the subject graph will display in bold lines.

e	Graph........................................ �Displays the traffic of each interface in the graph.
	� The lines are distinguished in the colors on the interface list.

r	[Display]................................... �Click to start searching and display on the graph.

3.	Access Point menu (Continued)
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!1	Wireless Analyzer.................... �Displays the surrounding radio wave environment in a graph based on 
the data imported from the access point.

	 • �The access points’ display names without colors on the map screen are the 
analyzing targets. 

	 • �While analyzing, the analyzing access point cannot communicate with a wire-
less LAN terminal.

	 Horizontal axis:	Frequency
	 Vertical axis:	 Signal strength 

3.	Access Point menu (Continued)

Radio wave intensity 
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!1 Wireless Analyzer
 ...(Continued) ..........................  Channel
 Select the scanning range of channels from the displayed list.
 (Default: 001-005 CH (2412-2432 MHz))

 • The selectable channels differ, depending on the country.

3. Access Point menu (Continued)

Click

!2  Lock Icons ...............................  You can lock the access point icons on the map screen so that they will 
not relocate accidentally.

 • To unlock, click to remove the check mark.

!3  Restart...  .................................  Restarts the selected access point.

!4  Restart (All)...  .........................  Restarts all the access point in the selected group.

Kq
Kw

Ke
Kr
Kt
Ky

Ku
Ki
Ko
K!0
K!1

K!2

K!4
K!3

Click



3 MENU

3-24

4. Option menu

This menu is for automatic control, saving the log and so on.

Kq
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q  Automatic ................................  Displays the menu to select the automatic Firmware Update, Start 
Management and so on.

 q  Firmware Update ....................  If the fi rmware does not match the RS-AP3’s fi rmware, the access point’s 
fi rmware automatically updates.

 •  Select to update the firmware as soon as a different version is detected by se-
lecting “At all times,” or assign the time to update the firmware by selecting the 
time.

   – The assigned time is synchronized with the time on your PC.
 • If time is selected, a firmware update starts at the assigned time.
   –  When the firmware update does not complete during the assigned time, the 

update is canceled.
   –  After updating the firmware, the setting data does not match with the RS-AP3’s 

data. Therefore, the setting data needs to be sent to the access point.
      (Option > Automatic > Settings Update) (+p.3-25)
       If the firmware update and the settings update time are assigned in the same 

hour, the firmware is updated first, and then the setting data is updated.
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4. Option menu (Continued)

q  Automatic (continued) ...........  

 w  Settings Update ......................  If the setting data does not match the RS-AP3’s setting data, it automati-
cally sends to the access point.

 •  Select to send the setting data as soon as a different data is detected by select-
ing “At all times,” or assign the time to send by selecting the time.

   – The assigned time is synchronized with the time on your PC.
 • If time is selected, the data is sent to update at the assigned time.
   –  When the updating does not complete during the assigned time, the updating 

is canceled.
   – This function can be used with the Firmware Update function.
      (Option > Automatic > Firmware Update) (+p.3-24)
       If the firmware update and the settings update time are assigned in the same 

hour, the firmware is updated first, and then the setting data is updated.
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4.	Option menu (Continued)

q	Automatic (continued)............ �

e	Start Management................... �If an access point that is not being managed is found, this option will 
automatically start managing.

	 • �“Access Point Management Tools” must be enabled, and the access point must 
be located and set on the map screen to start its management.

r	Automatic Control...................Enables or disables the Automatic Control function.
	 • �Select the channels that can automatically be controlled in the “Channel List.”
	 • �If the function is enabled, “Automatic Control” in the “Group” menu is also en-

abled. (+p.3-5)

	 Channel List...	� Selects channels to be automatically controlled. Select one or 
more channels each from the 2.4GHz and 5GHz channels. 

			�   • �If the selected channels do not include the supported band-
width, the first channel which includes the supported band-
width is automatically selected.
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w	Save the Log............................ �Displays the saving options for illegal access detection, SYSLOG and so on.

q	Output Log............................... �Saves the information on the server or the illegal access detection log history.

w	Illegal Access
	 Detection Log.......................... �Saves the received illegal access detection as a log.

e	SYSLOG................................... �Saves the received SYSLOG when using the SYSLOG server in a file 
(Extension: txt).

			   • �Depending on the capacity of the received SYSLOG or the saving speed, the 
SYSLOG processing may be delayed. In that case, all the delayed SYSLOGs 
are deleted and outputs a message in the log.

r	Traffic Statistics....................... �Saves the traffic statistics as a log.

4.	Option menu (Continued)
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4.	Option menu (Continued)
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w	Save the Log (continued)........

t	Log Folder................................Sets the folder to save the logs and manages the stored log.

	 Log Management
	 Target:		  Click to check the logs to delete automatically.

	 Storing Period (days):	� Select number of days to keep the logs from “30,” “60,” 
or “90.”	 (Default: 30 (days))

	 Delete All Traffic 
	 Statistics Log:	 	� Click <Delete>, then click <Yes> to manually delete all 

the traffic statistics logs except the current day, regard-
less of the “Storing Period (days)” setting. 

	 Delete the Other Logs:	� Click <Delete>, then click <Yes> to manually delete all 
of the output logs, illegal access detection logs, and 
SYSLOG logs, except the current day, regardless of 
the “Storing Period (days)” setting. 
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4.	Option menu (Continued)
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e	MAC Authentication
	 Server....................................... �You can register up to 10000 MAC addresses used for the MAC authen-

tication server (RADIUS.)

• The RS-AP3’s MAC Authentication Server function 
  (RADIUS) cannot be used as the VLAN authentication 
  server. (Attribute responder not supported)

☞☞ (Continued on the next page)

	 • �The following setting is when the RS-AP3 MAC authentication server is enabled 
in the “MAC Authentication Server (RADIUS)” setting on the “Common Configu-
ration” screen.
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4.	Option menu (Continued)

e	MAC Authentication
	 Server...(Continued)................

q	Import....................................... �Imports the MAC address information (extension: txt) to the RS-AP3.
	 • �The previously registered MAC address will be overwritten.
	 • �You can import only the file that is exported from [Export...] (w).

w	Export....................................... �Exports the registered MAC address information as a text file (extension: 
txt) to a desired location.

	 • �The following MAC addresses are taken as identical.
	  (Example: 0090C7777777 and 00-90-C7-77-77-77) 

e	Enable Server.......................... �Enables the RS-AP3’s MAC authentication server.

r	Authentication Policy.............. �Selects whether or not to allow to access from a wireless LAN terminal 
that has its MAC address registered.		         (Default: Allow List)

	 Allow List:	� Allows to access from only the registered wireless LAN 
terminals.

			   • �All the terminals with MAC addresses that are not registered 
are denied.

	 Deny List:	� Denies to access from only the registered wireless LAN 
terminals.

			   • �All the terminals with MAC addresses that are not registered 
are allowed.
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4.	Option menu (Continued)

r	Roaming Caching.................... �Enables the PMK (Pairwise Master Key) Caching function that minimizes 
the communication interruptions by leaving out some parts of the authen-
tication, when the wireless LAN terminal roams to other access points.

	 • �The PMK Caching function can be used when “WPA2” or “WPA/WPA2” authen-
tication is used.

RS-AP3
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RADIUS server
Wireless access
point A

Wireless access
point B

Wireless LAN terminal Wireless LAN terminal

Sends PMK Caching
to the RS-AP3

Authorized by the
RADIUS server

Access point A
accessing the RADIUS server

Accessing access point A

Moving

If there is a correct 
PMK Caching, skips
the authentication, 
and enables
connection.

When accessing
access point B, 
sends the caching
information from
accessing the acces
point A.

If you receive caching information 
while changing to access point B 
by roaming, it will not communicate
withthe RADIUS server and checks
for the PMK caching with the RS-AP3.

☞☞ (Continued on the next page)

NOTE
• All the PMK cachings are deleted when the setting data is saved to the RS-AP3.
• Up to 16 PMK cachings can be held in each wireless LAN.
	 When the amount of the PMK cachings exceed more than 16, the older PMK cachings are deleted.
	 Also, the PMK cachings that exceed the PMK Caching Timeout are deleted. (+p.3-32)
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4.	Option menu (Continued)

r	Roaming Caching...
	 (Continued).............................. �

q	Roaming Caching.................... �Enables or disables the Roaming Caching function.	 (Default: Enable)

w	PMK Caching Timeout
	 (minutes).................................. �If necessary, set the timeout period until the PMK caching is automati-

cally deleted.
	 • �Set the period between 1 and 1440 minutes. 		  (Default: 720)

K
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PMK Caching sharing function setting (Authentication/RADIUS)
In the Wireless Settings on the “Common Configuration” screen, Set “WPA2,” or “WPA/WPA2,” and the RADIUS 
server. (As shown in the screen below)
To apply the changes, overwrite the settings, and then send the setting data to the access points. (+p.1-18 to p.1-20)
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4.	Option menu (Continued)

t	Email......................................... �Displays the “Email Settings” window to send access point information by 
email.

	 • �Refer to “Notification by email function” on page 6-2 of this manual for more 
details.

y	Mirroring................................... �Displays the Mirroring function menu. 

	� Having the Mirroring function enabled will avoid being disabled by inter-
ferences.

	� If you enable, the setting data on this PC is synchronized with another 
PC with the RS-AP3.

	 • �Refer to “To prevent the management inability” on page 6-7 for the setting 
details.

q	Status... .................................... �Displays the “Mirroring Status” window after enabling the mirroring func-
tion to confirm the setting options that are not synchronized. (+p.6-13)

	 • �Double-clicking “Synchronized” or “Unsynchronized” will also display the win-
dow.

w	Options..................................... �Displays the “Mirroring Option” window to set the mirroring function. 
(+p.6-8)

e	Synchronize............................. �Displays the “ Mirroring” window to synchronize the Primary and the Sec-
ondary settings after enabling the mirroring function. (+p.6-10)
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4.	Option menu (Continued)

u	Fault Log Timer........................ �When there is no notification from the access point for this setting time 
period, the access point icon blinks red, informs on the “Log Output” 
screen, and/or by sending a notification email, if set (+p.6-2)

			   Set to between 1 and 5 minutes.

Binks red when no notification from the access point 
for this setting time period.
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5.	View menu 

q	Caption Bar.............................. �Set whether or not to display the caption bar.

w	Tool Bar....................................Set whether or not to display the tool bar.

e	Status Bar................................ �Set whether or not to display the status bar.

r	Output Log............................... �Set whether or not to display the “Output Log” screen. 

t	Property.................................... �Set whether or not to display the “Property” screen. 

This menu is for the RS-AP3’s view settings.

Tool Bar

Status Bar
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Output Log

Property
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6.	Help menu 

This menu displays the RS-AP3’s instruction manual (this manual) and the version information.

q	Manual...................................... �Opens this instruction manual.

w	About........................................Displays the software, version and copyright information.
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1.	Operating

Click the “Individual Configurations” tab to display the access points in the selected group.
Select an access point, and then change the settings. (+p.4-3 to p.4-9)
• To apply the changes, overwrite the settings, and then send the setting data to the access points.
  (+p.1-18 to p.1-20)

q Click

w Selectr Save e Check

The settings on the “Property” screen can also be 
set on this list. (+p.2-9)
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2.	 IP Address

Set “Host Name” and “Management VLAN ID” of the selected access point.
• To apply the changes, overwrite the settings, and then send the setting data to access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.

Setting the Host Name

Enter a desired host name of up the 31 characters (a to z, A to Z, 0 to 9 and - (hyphen)).
A name starting or ending with a “-” (hyphen) cannot be registered.
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3.	DHCP Server

Set “DHCP Server” and “Static DHCP” for the selected access point.
• To apply the changes, overwrite the settings, and then send the setting data to access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.



4 INDIVIDUAL CONFIGURATIONS

4-5

4.	Packet Filter

Set “Packet Filter” for the selected access point.
• To apply the changes, overwrite the settings, and then send the setting data to access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.

☞☞ (Continued on the next page)

Click a Packet Filter number (Entry) to 
set “Use Common Configuration,” “Dis-
able” or “Enable” to whether or not to use 
a programmed filter.
(Default: Use Common Configuration)
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Packet Filter Import/Export function

The “Import/Export/Use Common Configuration for All/Delete All” option can only be used when the RS-
AP3 is used with Icom’s access points.
The import, export, and packet filter settings can be simultaneously set to the selected access points.

4.	Packet Filter (Continued)

q Exporting
	  Exports the programmed packet filter as a text file (extension: txt.)
	  1.	Select “Export.”
	  	 • When no packet filter is programmed, “No settings to export.” is displayed.
	  2.	Set a desired file name, and then click [Save].
		  • The exported file can be edited with a text editor.

w Importing
	  Imports exported files.
	  1.	Select “Import.”
	  2.	Select a file for the packet filter, and then click [Open].
	  3.	Click [OK].
	  	 • The existing packet filter is overwritten.
	  	 • You can import only the file that is exported from [Export].

e Setting all packet filters
	  1.	Select “Use Common Configuration for All” or “Delete All.”
	  2.	Click [Yes] to set or delete all packet filters that are programmed to the selected access points.
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5.	Router Settings

Set “Change address” and “IP filter” for the selected access point.
• This screen is displayed only when a wireless access point with router function is selected.
• To apply the changes, overwrite the settings, and then send the setting data to access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.

Click an IP Filter number (Entry) to set 
“Use Common Configuration,” “Disable” 
or “Enable” to whether or not to use a 
programmed filter.
(Default: Use Common Configuration)
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IP Filter Import/Export function

The “Import/Export/Use Common Configuration for All” option can only be used when the RS-AP3 is used 
with Icom’s access points.
The import, export, and packet IP settings can be simultaneously set to the selected access points.

5.	Router Settings (Continued)

q Exporting
	  Exports the programmed IP filter as a text file (extension: txt.)
	  1.	Select “Export.”
	  	 • When no IP filter is programmed, “No settings to export.” is displayed.
	  2.	Set a desired file name, and then click [Save].
		  • The exported file can be edited with a text editor.

w Importing
	  Imports exported files.
	  1.	Select “Import.”
	  2.	Select a file for the IP filter, and then click [Open].
	  3.	Click [OK].
	  	 • The existing IP filter is overwritten.
	  	 • You can import only the file that is exported from [Export].

e Setting all IP filters
	  1.	Select “Use Common Configuration for All.”
	  2. Click [Yes] to set all IP filters that are programmed to the selected access points.
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When using the Wireless Bridging function

1.	�Before enabling the access point management tools, set the Wireless Bridging function on the access 
point’s setting screen.

2.	�Before starting the management of the contents set in the step 1, set the “Individual Configurations” 
screen.

	�� When the Wireless Bridging is interrupted by setting modifications, the monitoring or setting modifications for the 
target access point are disabled.

	� To modify the “Wireless Bridging” settings, start modifying from the access points that can only be communicated 
with the Wireless Bridging function.

	 • �When using the Wireless Bridging function with the Wireless 2 (external antenna’s LAN unit) on the Icom’s access 
points, the virtual AP on the “Common Configuration” also must be set.

	   Refer to the product’s instruction manual for more details.

6.	Wireless Settings

Set “Wireless Unit,” “Channel,” “Power Level” and so on for the selected access point.
• �When “Frequency Band” is set to “Use Common Configuration,” “Bandwidth,” “Channel” and “Power Level” cannot be 

set.
• To apply the changes, overwrite the settings, and then send the setting data to access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.
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7.	SNMP

Set “System Location” and “System Contact” for the SNMP (Simple Network Management Protocol.)
• To apply the changes, overwrite the settings, and then send the setting data to access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.
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8.	Command

The Command function is an expansion setting for the access point updates.
• This option is not used as of April 2022.
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1.	Operating

Click “Common Configuration” to display the configuration options to be commonly shared in the selected 
group.
If you change settings, the same settings are made to all the access points in the group. 
(+p.5-3 to p.5-10)
• To apply the changes, overwrite the settings, and then send the setting data to access points.
  (+p.1-18 to p.1-20)
• The Individual Configurations have higher priority over the Common Configuration. (+p.4-1)

q Click

e Save w Set
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2.	Model

Check the model of the access point assigned to the selected group.

Changing the model

To change the model that was selected when you created the group (+p.1-7), click on the model name, 
and then select from the drop down list.
• To apply the changes, overwrite the settings, and then send the setting data to the access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.
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3.	Network Settings

Set “Static Routing,” “Packet Filter” and so on to be commonly shared in the selected group.
• To apply the changes, overwrite the settings, and then send the setting data to the access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.

☞☞ (Continued on the next page)

With the “Import/Export/Delete All” option, you can 
import, export or delete all packet filters. (+p.4-6)
To delete all entries, select “Delete All.”

Click a packet filter number to select whether 
or not to use the entry. 	 (Default: Disable)
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3.	Network Settings (Continued)

Web Authentication (Advanced)

The “Import/Export/Delete All” option can only be used when the RS-AP3 is used with Icom’s access points.
You can import, export or delete all the entries on the local list on each virtual access point (interface.)

q Exporting
	  Exports the programmed local list as a text file (extension: txt.)
	  1.	Select “Export.”
	  	 • When no local list is programmed, “No items to export in the Local List.” is displayed.
	  2.	Set a desired file name, and then click [Save].
		  • The exported file can be edited with a text editor.

w Importing
	  Imports exported files.
	  1.	Select “Import.”
	  2.	Select a file for the local list, and then click [Open].
	  3.	Click [OK].
	  	 • The existing local list is overwritten.
	  	 • You can import only the file that is exported from [Export].

e Deleting all local lists
	  1.	Select “Delete All.”
	  2. Click [Yes] to delete all the local list that are registered in the selected virtual access point.
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4.	Router Settings

Set “IP filter” to be commonly shared in the selected group.
• This screen is displayed only when a wireless access point with router function is selected.
• To apply the changes, overwrite the settings, and then send the setting data to access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.

With the “Import/Export/Delete All” option, you can 
import, export or delete all IP filters. (+p.4-8)
To delete all entries, select “Delete All.”

Click an IP filter number to select whether or 
not to use the entry. 	 (Default: Disable)
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5.	Wireless Settings

Set “Bandwidth,” “Channel,” “Power Level” and so on to be commonly shared in the selected group.
• To apply the changes, overwrite the settings, and then send the setting data to wireless access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.

☞☞ (Continued on the next page)

Select “Enabled (RS-AP3)” when using the MAC Authen-
tication Server (RADIUS).
Refer to page 3-29 and 3-30 for the MAC Authentication 
Server settings.
• �The RS-AP3’s MAC Authentication Server function 

(RADIUS) cannot be used as the VLAN authentication 
server. (Attribute responder not supported)
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q Exporting
	  Exports the programmed MAC addresses as a text file (extension: txt.)
	  1.	Select “Export.”
	  	 • When no MAC address is programmed, “No MAC address to export.” is displayed.
	  2.	Set a desired file name, and then click [Save].
		  • The exported file can be edited with a text editor.
		  • The following MAC addresses are taken as identical address.
	  	   (Example: 0090C7777777 and 00-90-C7-77-77-77) 

w Importing
	  Imports exported files.
	  1.	Select “Import.”
	  2.	Select a file for the MAC address, and then click [Open].
	  3.	Click [OK].
	  	 • The existing MAC address is overwritten.
	  	 • You can import only the file that is exported from [Export].

e Deleting all MAC addresses
	  1.	Select “Delete All.”
	  2. �Click [Yes] to delete all the MAC addresses that are registered in the selected virtual access point.

5.	Wireless Settings (Continued)

Setting the MAC address filtering

The “Import/Export/Delete All” option can only be used when the RS-AP3 is used with Icom’s wireless ac-
cess points.
You can import, export or delete all the MAC addresses on each virtual access point (interface.)
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5.	Wireless Settings (Continued)

Setting the interference filtering

The “Interference Filtering” options can only be used when the RS-AP3 is used with Icom’s wireless access 
points.
The communication status is improved when a signal interference is found.
You can set the threshold level and the function to each wireless unit.
• The effects may differ, depending on the environment.
• �It is not necessary to always have the RS-AP3 connected after setting the filtering because it is controlled on the wire-

less access point side.

Threshold level
Select the filtering threshold level between “High,” “Middle,” and “Low.”	                         (Default: Disable)
The filtering is more sensitive while the threshold level is set to “Low.”

Stream number control
Select “Enable” to change between 2 streams and 1 stream.		                          (Default: Disable)
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5.	Wireless Settings (Continued)

Setting the schedule

The “Schedule” options can only be used when the RS-AP3 is used with Icom’s wireless access points.
You can set the day and the time for wireless shut down in up to 16 different ways to each wireless unit.
• The time is synchronized with the time set to the access point.
   We recommend that you enable the NTP function.
• �It is not necessary to always have the RS-AP3 connected after setting the schedule because it is controlled on the 

wireless access point side.

Set the wireless shutdown day and the time as shown above.
For example, if “Fri 23:00 - 06:00” is set, the wireless system is shutdown from Friday at 23:00 to Saturday 
at 06:00. When the shutdown time and the end time are set at same time (example: “00:00 - 00:00” or “12:34 
- 12:34”), the wireless system is shutdown for 24 hours.
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6.	Management

Set “Administrator,” “SYSLOG,” “SNMP” and so on to be commonly shared in the selected group.
• To apply the changes, overwrite the settings, and then send the setting data to the access points.
  (+p.1-18 to p.1-20)
• Refer to the instruction manual (PDF) or online help for Icom’s access point setting details.



5 COMMON CONFIGURATION

5-12

7.	Command

The Command function is an expansion setting for the access point updates.
• This option is not used as of April 2022.
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8.	Load Balancing

The Load Balancing function, that is commonly shared in the selected group, can be used only when Icom’s 
wireless access points and the RS-AP3 are used together.� (Default: Disable)
If you “Enable” the Load Balancing setting, this function distributes the loadings according the status of the ac-
cess points or wireless LAN terminals that is included in the regularly received information.
• �If “Disable” is selected, the Load Balancing function will not distribute loadings, even if the operating conditions are satis-

fied.
• In order to control the Load Balancing function, the RS-AP3 needs to be connected at all times.

Operating Conditions
If either the amount of connected wireless LAN terminals or the communication volume, or both reach the condi-
tions, the half of the connected wireless LAN terminals will be cut off.

• Amount of wireless LAN terminals may differ depending on the Maximum Number of Stations settings.
   

Maximum Number 
of Stations

5 or less 6 to 29 30 or more

Amount of wireless LAN 
terminals connected to the 

virtual AP

No limitation by 
amount

1 less than the set Maximum 
Number of Stations

Fixed 30, regardless of the 
Maximum Number

of Stations

• �When a virtual AP has communicated continuously with more than 96 Mbps speed for more than 30 seconds.

Operation
The half of the connected wireless LAN terminals will be cut off in order of the weakest signal, and re-connection 
will be inhibited for 60 seconds.

Example:
While the Balance Loading function is enabled and 9 wireless LAN terminals are connected to the Virtual AP 
with Maximum Number of Stations set to 10, cuts off 4 connected wireless LAN terminals in order of the weakest 
signal, and re-connection will be inhibited for 60 seconds.
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1.	Notification by email function

(Fault) [2 errors] Announcements from the RS-AP3

2014-06-12 08:08:50	 Notification on Faults

An error was reported from an access point under management.
2014-06-12 08:08:41 192.168.0.1 (New Group 01, New AP 01) 192.168.0.1: No notifications from the ac-
cess point for over 60 seconds.
2014-06-12 08:08:41 192.168.0.2 (New Group 01, New AP 02) 192.168.0.2: No notifications from the ac-
cess point for over 60 seconds.

No error was detected in Mirroring.

This function is to send access point information to the email address set beforehand.

Notification conditions
• When no notification is received from an access point for more than the time set in “Fault Log Timer” (+p.3-34).
• When the connection is rejected by the MAC address filtering system.
• When the connection is rejected by exceeding the maximum number of stations.
• When a station is disconnected by a MIC failure (replay protection) in the WPA authentication.

Notification examples
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1.	Notification by email function (Continued)

Setting the Notification by email

You need a network that can access a POP/SMTP server to use the Notification by email function.

Click “Option” and then “Email...”.
The “Email Settings” window is displayed.

1

Select “Enable.”
Clicking [X] on the window top before enabling the setting will close the window without saving the 
changes.

2

☞☞ (Continued on the next page)

Select

If necessary, set the options.
Refer to the next page for details.

w Clickq Click
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1.	Notification by email function (Continued)

Notification by email setting options

When the user authentication method is set to “POP before SMTP.”

q	Notification on Faults............. �Set “Enable” to send an email whenever an illegal access or notification 
fault is detected.		            (Default: Enable)

w	Regular Notification............... �Regularly sends access point information using the Notification by email 
function.	            (Default: Disable)

	 Options are added when this is set to “Enable.”

e	Email address 1~5 (To).......... �Enter up to 5 email addresses to send access point information to.

r	Email address (From)............. Enter the email address to send access point information from.

	 Interval (minutes)
	 Set the notification sending interval to between 1 and 9999 minutes.
		                     (Default: 10)
	 Notification with or without faults
	� If “Enable” is set, the notification is sent at regular intervals.
		             (Default: Disable)
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1.	Notification by email function (Continued)

Notification by email setting options (Continued)

t	SMTP Server........................... �Enter the server address to send the email.

y	Port.......................................... �Enter the server’s port number between 1 and 65535 to send the email.
	 (Default: 25)

u	User authentication................ �Set the user authentication method to send email.	  (Default: None)
None

	 Does not authenticate the user when sending the email.

	 POP before SMTP
	� Authorizes the use of SMTP server by accessing the selected POP serv-

er before sending the email.
	 • APOP (i) can also be used as a combination.

	 SMTP Authentication
	� Authorizes by adding the user authentication system to the SMTP which 

is the protocol to send the email.

i	APOP....................................... �Authentication method to encrypt the password to receive emails.
	 (Default: Disable)
	� POP generally sends the password in plain text. This may cause the 

password being peeped.
	� APOP enables you avoid this danger by encrypting the password to 

send.
	 • �This option is only displayed when “POP before SMTP” is selected as the User 

authentication (u.)

o	POP Server.............................. �Enter the POP server address.
	 • �This option is only displayed when “POP before SMTP” is selected as the User 

authentication (u.)
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1.	Notification by email function (Continued)

Notification by email setting options (Continued)

!0	User Name............................... �Enter the user name to access the POP or SMTP server.
	 • �This option does not display when “None” is selected for the User au-

thentication (u.) 

!1	Password................................. �Enter the password to access the POP or SMTP server.
	 • �This option does not display when “None” is selected for the User au-

thentication (u.) 

!2	[Send a test email].................. �Sends a test email to confirm the setting contents in the “Email Settings” 
window.

	� Click it, and when the dialog shown below appears, the test email has 
been sent to the set email address (e.) (☞p.6-4)

	 • �When multiple email addresses are set, the dialog appears if the test 
email has been successfully sent to any one of the set addresses.

!3	[OK].......................................... �Enables the settings set in the “Email Settings” window.
	 • �The window closes.

!4	[Cancel]................................... To cancel the change entry before saving.
	� To save the changes, click [OK].
	 • �The window closes.
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2.	To prevent the management inability

Set the Mirroring function that can synchronize the setting data with another PC with the RS-AP3 in-
stalled.
The function avoids disabilities of not being able to operate when one PC with the RS-AP3 installed has 
problems, and enables you to operate on the other PC (secondary) that is synchronized with the one with  
problems.
• �If you change the settings and save to overwrite after synchronizing the setting data, you need to synchronize again. 

(☞p.6-10)

Using the Mirroring function

➥➥ Prepare two RS-AP3s (USB flash drive with the same license.)
➥➥ Install the RS-AP3 on two PCs.

	 • Set the static IP addresses to the PCs.
	 • Set the same User ID and password for the primary and the secondary RS-AP3.
	 • The mirroring function cannot be used if the RS-AP3 versions are different.
	 • �All of these settings are described as if the access point (example: AP-90M) is operated from the pri-

mary RS-AP3.
	 • �Following the steps on page 6-8, set the mirroring function on the primary and secondary RS-AP3s.

Words used when setting
Primary:	 The daily used PC with the RS-AP3 installed.
Secondary:	� The PC with the RS-AP3 installed that is synchronized with the primary PC, when the mir-

roring function is used.
Local host:	 Directly used PC.
Remote host:	 Remotely controlled PC through a network.
				    (Primary to secondary or secondary to primary)

192.168.0.100

192.168.0.200
Insert the USB flash drive
that was used when you first
started the RS-AP3 after
installing it.
• The flash drive cannot be used 
  with multiple PCs.

HUBRS-AP3
Primary

RS-AP3
Secondary

• The settings on this illustration are only examples.
  These settings are also used in the instructions on the next page.

Wireless access point
(Example: AP-90M)
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2.	To prevent the management inability (Continued)

Setting the Mirroring function

Enable the mirroring function of the RS-AP3s on the primary and secondary PCs.

Click “Option” > “Mirroring” > “Options...”
The “Mirroring Option” window is displayed.

1

Select “Enable” for “Mirroring.”2

Select the Priority (Local Host) and the IP Address (Local Host.)
Primary:	 192.168.0.100

Secondary:	 192.168.0.200

3

 Select

 Select

 Select

w Click e Clickq Click
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Setting the Mirroring function (Continued)

Enter the Remote Host’s IP address and the password for synchronization.
• Enter a desired password of up to 31 characters. 
	 The password will be displayed in asterisks.
• Set the same synchronization password (example: icom) to the primary and the secondary.

Primary:	 192.168.0.200/icom

Secondary:	 192.168.0.100/icom

4

Click “OK.”
• Follow the steps on the next page to synchronize the setting data.

5

Enter

Enter

Click

2.	To prevent the management inability (Continued)
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2.	To prevent the management inability (Continued)

Synchronizing the setting data

After enabling the mirroring function of the primary and secondary PCs, follow the instructions below to 
synchronize the setting data.

Click “Option” > “Mirroring” > “Synchronize...”.
The “Mirroring” window is displayed.

1

Select the synchronizing method, and then click [OK].
“Synchronizing settings. Wait a moment.” is displayed.

2

q Click w Click e Click

q	Synchronize by sending the configuration
	� To send the setting data modified in the local host to the remote host to synchronize them, the 

previous setting data is overwritten.

192.168.0.100

192.168.0.200

HUBRS-AP3
Primary

RS-AP3
Secondary

The USB flash drive must be 
inserted when synchronizing 
with the mirroring function.

(Local host)

(Remote host)

Wireless access point
(Example: AP-90M)

☞☞ (Continued on the next page)

q Select

w Click

Kq

Kw
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2.	To prevent the management inability (Continued)

Synchronizing the setting data (Continued)

Check on the status bar as to whether or not the setting data is synchronized.
• “Synchronized” is also displayed on the remote host.

3

2

w	Synchronize by receiving the configuration
	� The local host receives setting data saved on the remote host and synchronizes.
	 • When this method is selected, the setting data is not overwritten.

192.168.0.100

192.168.0.200

HUBRS-AP3
Primary

RS-AP3
Secondary

The USB flash drive must be 
inserted when synchronizing 
with the mirroring function.

(Local host)

(Remote host)

Wireless access point
(Example: AP-90M)

q Select

w Click

Kq

Kw
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2. To prevent the management inability (Continued)

Causes and counterplans for error messages

Cause:  The USB fl ash drive is not inserted into the local host.
Counterplan: Insert the USB fl ash drive, and click [Retry].

Cause:  The Mirroring function is not set correctly.
Counterplan:  Click [OK] to check the settings on the “Mirroring Option” screen (+p.6-8) and then try to 

synchronize again.

Click

Click
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2.	To prevent the management inability (Continued)

Checking the unsynchronized settings

Double-click “Synchronized/Unsynchronized” on the status bar.
The “Mirroring Status” screen is displayed.

1

Check the settings that are not yet synchronized.
The unsynchronized settings have a pink background.

2

3

Check

This shows that there is a mismatch with the setting data 
on the remote host.
• �“Unsynchronized” is displayed on the screen in step 1, 

when the setting data is saved on the local host after 
modifying the access point settings.

Close the “Mirroring Status” screen to send the setting data to the remote host, and then start syn-
chronization. (☞p.6-10)
The status display will change to “Synchronized.”

Double-click

Double-click
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3.	Background bitmap setting

�Save the desired bitmap formatted (24 bit) image file in the “BG” folder that is located in the same location 
as the RS-AP3. 
Example: Setting “room.bmp” as the background bitmap.

Save “room.bmp” in the RS-AP3’s “BG” folder.
The “BG” folder is located in “Icom” > “RS-AP3” in the RS-AP3 installation folder.

1

Start the RS-AP3.2

Select the group to set the background.
Click “” and select “room.bmp” from the displayed image file list.

3

Click “Zoom in/out” to adjust the background size between 50 % and 300 %.4

w Clickq Select

e Select

Displays the bitmap formatted 
image files saved in the “BG” 
folder.

wAdjust

q Click

You can also adjust 
the background size 
by directly entering 
the percentage.
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4.	Firewall setting

RS-AP3 communication may be blocked by your firewall.
When the communication is blocked, enable the protocol and the port number used for the communication 
to unblock and proceed the communication.
• Refer to the instruction manual of your firewall software used for its setting details.
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UDP 9992/9993/9994, TCP 9994/9995: Transmitting and receiving
UDP 9991, UDP 9995: Receiving
TCP 9995: Also used with the mirroring setting synchronization
UDP 9995/ICMP: Also used with the mirroring function

Illustration: Transmitting and destination of TCP, UDP

To UDP 9991� From UDP 9991

To UDP 9992� From UDP random

To UDP 9993� From UDP random

To TCP 9994� From TCP random

From TCP random� To TCP 9995

To UDP 9995� From UDP random (multicast: 239.0.99.95)

From UDP 9992� To UDP random

From UDP 9993� To UDP random

From TCP 9994� To TCP random

To TCP random� From TCP 9995

To UDP 9995� From UDP 9995 

ICMP

� ICMP

To UDP 9994� From UDP random

From UDP 9994� To UDP random
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